Chapter 206

Non-Unity Null Tests for the Ratio of Two Proportions

Introduction

This module computes power and sample size for hypothesis tests of the ratio of two independent proportions where the null-hypothesized value is not equal to one. The non-offset case is available in another procedure. This procedure compares the power achieved by each of several test statistics.

The power calculations assume that independent, random samples are drawn from two populations.

Technical Details

Suppose you have two populations from which dichotomous (binary) responses will be recorded. The probability (or risk) of obtaining the event of interest in population 1 (the treatment group) is $p_1$ and in population 2 (the control group) is $p_2$. The corresponding failure proportions are given by $q_1 = 1 - p_1$ and $q_2 = 1 - p_2$.

An assumption is made that the responses from each group follow a binomial distribution. This means that the event probability, $p_i$, is the same for all subjects within the group and that the response from one subject is independent of that of any other subject.

Random samples of $m$ and $n$ individuals are obtained from these two populations. The data from these samples can be displayed in a 2-by-2 contingency table as follows

<table>
<thead>
<tr>
<th>Group</th>
<th>Success</th>
<th>Failure</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment</td>
<td>$a$</td>
<td>$c$</td>
<td>$m$</td>
</tr>
<tr>
<td>Control</td>
<td>$b$</td>
<td>$d$</td>
<td>$n$</td>
</tr>
<tr>
<td>Total</td>
<td>$s$</td>
<td>$f$</td>
<td>$N$</td>
</tr>
</tbody>
</table>

The following alternative notation is sometimes used.

<table>
<thead>
<tr>
<th>Group</th>
<th>Success</th>
<th>Failure</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment</td>
<td>$x_{11}$</td>
<td>$x_{12}$</td>
<td>$n_1$</td>
</tr>
<tr>
<td>Control</td>
<td>$x_{21}$</td>
<td>$x_{22}$</td>
<td>$n_2$</td>
</tr>
<tr>
<td>Total</td>
<td>$m_1$</td>
<td>$m_2$</td>
<td>$N$</td>
</tr>
</tbody>
</table>

The binomial proportions, $p_1$ and $p_2$, are estimated from these data using the formulae

$$\hat{p}_1 = \frac{a}{m} = \frac{x_{11}}{n_1} \quad \text{and} \quad \hat{p}_2 = \frac{b}{n} = \frac{x_{21}}{n_2}$$
Non-Unity Null Tests for the Ratio of Two Proportions

Comparing Two Proportions

When analyzing studies such as this, you usually want to compare the two binomial probabilities, \( p_1 \) and \( p_2 \). The most direct method of comparing these quantities is to calculate their difference or their ratio. If the binomial probability is expressed in terms of odds rather than probability, another measure is the odds ratio. Mathematically, these comparison parameters are

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Computation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Difference ( \delta )</td>
<td>( p_1 - p_2 )</td>
</tr>
<tr>
<td>Risk Ratio ( \phi )</td>
<td>( \frac{p_1}{p_2} )</td>
</tr>
<tr>
<td>Odds Ratio ( \psi )</td>
<td>( \frac{\frac{p_1}{1-p_1}}{\frac{p_2}{1-p_2}} = \frac{p_1 q_2}{p_2 q_1} )</td>
</tr>
</tbody>
</table>

The choice of which of these measures is used might seem arbitrary, but it is not. Not only will the interpretation be different, but, for small sample sizes, the powers of tests based on different parameters will be different. The non-null case is commonly used in equivalence and non-inferiority testing.

Ratio

The (risk) ratio, \( \phi = \frac{p_1}{p_2} \), gives the relative change in the disease risk due to the application of the treatment. This parameter is also direct and easy to interpret. To compare this with the difference, consider a treatment that reduces the risk of disease from 0.1437 to 0.0793. One should consider which single number is more enlightening, the fact that the absolute risk of disease has been decreased by 0.0644, or the fact that risk of disease in the treatment group is only 55.18% of that in the control group. In many cases, the percentage (risk ratio) communicates the impact of the treatment better than the absolute change.

Perhaps the biggest drawback to this parameter is that it cannot be calculated in one of the most common experimental designs, the case-control study. Another drawback is that the odds ratio occurs directly in the likelihood equations and as a parameter in logistic regression.

Hypothesis Tests

Although several statistical tests are available for testing the inequality of two proportions, only a few can be generalized to the non-null case. No single test is the champion in every situation, so one should compare the powers of the various tests to determine which to use.

Ratio

The (risk) ratio, \( \phi = \frac{p_1}{p_2} \), is often preferred as a comparison parameter because it expresses the difference as a percentage rather than an amount. Three sets of statistical hypotheses can be formulated:

1. \( H_0: \frac{p_1}{p_2} = \phi_0 \) versus \( H_1: \frac{p_1}{p_2} \neq \phi_0 \); this is often called the two-tailed test.
2. \( H_0: \frac{p_1}{p_2} \leq \phi_0 \) versus \( H_1: \frac{p_1}{p_2} > \phi_0 \); this is often called the upper-tailed test.
3. \( H_0: \frac{p_1}{p_2} \geq \phi_0 \) versus \( H_1: \frac{p_1}{p_2} < \phi_0 \); this is often called the lower-tailed test.
Power Calculation

The power for a test statistic that is based on the normal approximation can be computed exactly using two binomial distributions. The following steps are taken to compute the power of such a test.

1. Find the critical value (or values in the case of a two-sided test) using the standard normal distribution. The critical value, $z_{critical}$, is that value of $z$ that leaves exactly the target value of alpha in the appropriate tail of the normal distribution. For example, for an upper-tailed test with a target alpha of 0.05, the critical value is 1.645.

2. Compute the value of the test statistic, $z_t$, for every combination of $x_{11}$ and $x_{21}$. Note that $x_{11}$ ranges from 0 to $n_1$, and $x_{21}$ ranges from 0 to $n_2$. A small value (around 0.0001) can be added to the zero cell counts to avoid numerical problems that occur when the cell value is zero.

3. If $z_t > z_{critical}$, the combination is in the rejection region. Call all combinations of $x_{11}$ and $x_{21}$ that lead to a rejection the set $A$.

4. Compute the power for given values of $p_{1,1}$ ($p_1$ under the alternative) and $p_2$ as

$$1 - \beta = \sum_{A} \binom{n_1}{x_{11}} p_{1,1}^{x_{11}} q_{1,1}^{n_1-x_{11}} \binom{n_2}{x_{21}} p_{2}^{x_{21}} q_{2}^{n_2-x_{21}}.$$

5. Compute the actual value of alpha achieved by the design by substituting $p_{1,0}$ ($p_1$ under the null) for $p_{1,1}$ to obtain

$$\alpha^* = \sum_{A} \binom{n_1}{x_{11}} p_{1,0}^{x_{11}} q_{1,0}^{n_1-x_{11}} \binom{n_2}{x_{21}} p_{2}^{x_{21}} q_{2}^{n_2-x_{21}}.$$

Asymptotic Approximations

When the values of $n_1$ and $n_2$ are large (say over 200), these formulas often take a long time to evaluate. In this case, a large sample approximation is used. The large sample approximation is made by replacing the values of $\hat{p}_1$ and $\hat{p}_2$ in the $z$ values with the corresponding values of $p_1$ and $p_2$ under the alternative hypothesis and then computing the results based on the normal distribution. Note that in large samples, the Farrington and Manning statistic is substituted for the Gart and Nam statistic.

Test Statistics

Several test statistics have been proposed for testing whether the difference, ratio, or odds ratio are different from a specified value. The main difference among the several test statistics is in the formula used to compute the standard error used in the denominator. These tests are based on the following $z$-test

$$z_t = \frac{\hat{p}_1 - \hat{p}_2 - \delta_0 - c}{\hat{\delta}}$$

The constant, $c$, represents a continuity correction that is applied in some cases. When the continuity correction is not used, $c$ is zero. In power calculations, the values of $\hat{p}_1$ and $\hat{p}_2$ are not known. The corresponding values of $p_1$ and $p_2$ under the alternative hypothesis are reasonable substitutes.

Following is a list of the test statistics available in PASS. The availability of several test statistics begs the question of which test statistic you should use. The answer is simple: you should use the test statistic that you will use to analyze your data. You may choose a method because it is a standard in your industry, because it seems to have better statistical properties, or because your statistical package calculates it. Whatever your reasons for selecting a certain test statistic, you should use the same test statistic during power or sample calculations.
Non-Unity Null Tests for the Ratio of Two Proportions

Miettinen and Nurminen’s Likelihood Score Test

Miettinen and Nurminen (1985) proposed a test statistic for testing whether the ratio is equal to a specified value, $\phi_0$. The regular MLE’s, $\hat{p}_1$ and $\hat{p}_2$, are used in the numerator of the score statistic while MLE’s $\tilde{p}_1$ and $\tilde{p}_2$, constrained so that $\tilde{p}_1 / \tilde{p}_2 = \phi_0$, are used in the denominator. A correction factor of $N/(N-1)$ is applied to make the variance estimate less biased. The significance level of the test statistic is based on the asymptotic normality of the score statistic.

The formula for computing the test statistic is

$$ z_{MNR} = \frac{\hat{p}_1 / \hat{p}_2 - \phi_0}{\left(\frac{\tilde{p}_1 \tilde{q}_1 + \phi_0^2 \tilde{p}_2 \tilde{q}_2}{n_1} + \frac{\phi_0}{n_2}\right) \left(\frac{N}{N-1}\right)} $$

where

$$ \tilde{p}_1 = \tilde{p}_2 \phi_0 $$

$$ \tilde{p}_2 = -\frac{B - \sqrt{B^2 - 4AC}}{2A} $$

$$ A = N\phi_0 $$

$$ B = -\left(n_1\phi_0 + x_{11} + n_2 + x_{21}\phi_0\right) $$

$$ C = n_1 $$

Farrington and Manning’s Likelihood Score Test

Farrington and Manning (1990) proposed a test statistic for testing whether the ratio is equal to a specified value, $\phi_0$. The regular MLE’s, $\hat{p}_1$ and $\hat{p}_2$, are used in the numerator of the score statistic while MLE’s $\tilde{p}_1$ and $\tilde{p}_2$, constrained so that $\tilde{p}_1 / \tilde{p}_2 = \phi_0$, are used in the denominator. A correction factor of $N/(N-1)$ is applied to increase the variance estimate. The significance level of the test statistic is based on the asymptotic normality of the score statistic.

The formula for computing the test statistic is

$$ z_{FMR} = \frac{\hat{p}_1 / \hat{p}_2 - \phi_0}{\left(\frac{\tilde{p}_1 \tilde{q}_1 + \phi_0^2 \tilde{p}_2 \tilde{q}_2}{n_1}\right)} $$

where the estimates, $\tilde{p}_1$ and $\tilde{p}_2$, are computed as in the corresponding test of Miettinen and Nurminen (1985) given above.
Gart and Nam’s Likelihood Score Test

Gart and Nam (1988), page 329, proposed a modification to the Farrington and Manning (1988) ratio test that corrected for skewness. Let \( z_{FMR}(\phi) \) stand for the Farrington and Manning ratio test statistic described above. The skewness corrected test statistic, \( z_{GNR} \), is the appropriate solution to the quadratic equation

\[
(\bar{\phi}) z_{GNR}^2 + (\bar{\phi}) z_{GNR} + \left( z_{FMR}(\phi) + \bar{\phi} \right) = 0
\]

where

\[
\bar{\phi} = \frac{1}{6\tilde{u}^{3/2}} \left( \frac{\tilde{q}_1(\tilde{q}_1 - \tilde{p}_1)}{n_1\tilde{p}_1^2} - \frac{\tilde{q}_2(\tilde{q}_2 - \tilde{p}_2)}{n_2\tilde{p}_2^2} \right)
\]

\[
\tilde{u} = \frac{\tilde{q}_1}{n_1\tilde{p}_1} + \frac{\tilde{q}_2}{n_2\tilde{p}_2}
\]

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains the parameters associated with this test such as the proportions, ratios, sample sizes, alpha, and power.

Solve For

This option specifies the parameter to be solved for using the other parameters. The parameters that may be selected are Power, Sample Size, and Effect Size.

Select Power when you want to calculate the power of an experiment.

Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.

Power Calculation

Power Calculation Method

Select the method to be used to calculate power. When the sample sizes are reasonably large (i.e. greater than 50) and the proportions are between 0.2 and 0.8 the two methods will give similar results. For smaller sample sizes and more extreme proportions (less than 0.2 or greater than 0.8), the normal approximation is not as accurate so the binomial calculations may be more appropriate.

The choices are

- **Binomial Enumeration**
  
  Power for each test is computed using binomial enumeration of all possible outcomes when \( N1 \) and \( N2 \leq \) Maximum \( N1 \) or \( N2 \) for Binomial Enumeration (otherwise, the normal approximation is used). Binomial enumeration of all outcomes is possible because of the discrete nature of the data.
Non-Unity Null Tests for the Ratio of Two Proportions

- Normal Approximation
  Approximate power for each test is computed using the normal approximation to the binomial distribution.

Actual alpha values are only computed when “Binomial Enumeration” is selected.

---

**Power Calculation – Binomial Enumeration**

**Options**

*Only shown when Power Calculation Method = “Binomial Enumeration”*

**Maximum N1 or N2 for Binomial Enumeration**

When both N1 and N2 are less than or equal to this amount, power calculations using the binomial distribution are made. The value of the “Actual Alpha” is only calculated when binomial power calculations are made.

When either N1 or N2 is larger than this amount, the normal approximation to the binomial is used for power calculations.

**Zero Count Adjustment Method**

Zero cell counts cause many calculation problems when enumerating binomial probabilities. To compensate for this, a small value (called the “Zero Count Adjustment Value”) may be added either to all cells or to all cells with zero counts. This option specifies which type of adjustment you want to use.

Adding a small value is controversial, but may be necessary. Some statisticians recommend adding 0.5 while others recommend 0.25. We have found that adding values as small as 0.0001 seems to work well.

**Zero Count Adjustment Value**

Zero cell counts cause many calculation problems when enumerating binomial probabilities. To compensate for this, a small value may be added either to all cells or to all zero cells. This is the amount that is added. We have found that 0.0001 works well.

Be warned that the value of the ratio will be affected by the amount specified here!

---

**Test**

**Alternative Hypothesis**

Specify the direction of the alternative hypothesis, H1.

- **One-Sided (H1: P1/P2 < R0)**
  Refers to a lower-tailed, one-sided test in which the alternative hypothesis is H1: P1/P2 < R0.

- **One-Sided (H1: P1/P2 > R0)**
  Refers to an upper-tailed, one-sided test in which the alternative hypothesis is H1: P1/P2 > R0.

- **Two-Sided (H1: P1/P2 ≠ R0)**
  Refers to a two-sided test in which the alternative hypothesis is H1: P1/P2 ≠ R0.

For one-sided tests, the direction you select must match the values entered for R0 and R1. For example, if you select H1: P1/P2 < R0, then the value(s) for R1 must be less than the value(s) for R0.

**Test Type**

Specify which test statistic is used in searching and reporting.
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal proportions when in fact they are different.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal proportions when in fact they are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on $N_1$ or $N_2$ or both.

The options are

- **Equal ($N_1 = N_2$)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter $N_1$, solve for $N_2$**
  Select this option when you wish to fix $N_1$ at some value (or values), and then solve only for $N_2$. Please note that for some values of $N_1$, there may not be a value of $N_2$ that is large enough to obtain the desired power.

- **Enter $N_2$, solve for $N_1$**
  Select this option when you wish to fix $N_2$ at some value (or values), and then solve only for $N_1$. Please note that for some values of $N_2$, there may not be a value of $N_1$ that is large enough to obtain the desired power.

- **Enter $R = N_2/N_1$, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the ratio of $N_2$ to $N_1$, and then PASS determines the needed $N_1$ and $N_2$, with this ratio, to obtain the desired power. An equivalent representation of the ratio, $R$, is

  $$N_2 = R \times N_1.$$ 

- **Enter percentage in Group 1, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed $N_1$ and $N_2$ with this percentage to obtain the desired power.
**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter N1 and N2 individually**
  This choice permits you to enter different values for N1 and N2.
• **Enter N1 and R, where N2 = R \times N1**
  Choose this option to specify a value (or values) for \( N1 \), and obtain \( N2 \) as a ratio (multiple) of \( N1 \).

• **Enter total sample size and percentage in Group 1**
  Choose this option to specify a value (or values) for the total sample size \( (N) \), obtain \( N1 \) as a percentage of \( N \), and then \( N2 \) as \( N - N1 \).

**Sample Size Per Group**

*This option is displayed only if Group Allocation = “Equal \((N1 = N2)\).”*

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for \( N1 \), and also the value for \( N2 \).

The Sample Size Per Group must be \( \geq 2 \). You can enter a single value or a series of values.

**N1 (Sample Size, Group 1)**

*This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = R \times N1.”*

\( N1 \) is the number of items or individuals sampled from the Group 1 population.

\( N1 \) must be \( \geq 2 \). You can enter a single value or a series of values.

**N2 (Sample Size, Group 2)**

*This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”*

\( N2 \) is the number of items or individuals sampled from the Group 2 population.

\( N2 \) must be \( \geq 2 \). You can enter a single value or a series of values.

**R (Group Sample Size Ratio)**

*This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R \times N1.”*

\( R \) is the ratio of \( N2 \) to \( N1 \). That is,

\[ R = \frac{N2}{N1} \]

Use this value to obtain \( N2 \) as a multiple (or proportion) of \( N1 \).

\( N2 \) is calculated from \( N1 \) using the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1.

\( R \) must be greater than 0. If \( R < 1 \), then \( N2 \) will be less than \( N1 \); if \( R > 1 \), then \( N2 \) will be greater than \( N1 \). You can enter a single value or a series of values.

**Total Sample Size (N)**

*This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”*

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines \( N1 \) and \( N2 \).

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.
Non-Unity Null Tests for the Ratio of Two Proportions

Percent in Group 1

This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

Effect Size – Ratios

R0 (Ratio|H0 = P1.0/P2)

This option specifies the ratio between the group 1 proportion under the null hypothesis P1.0 and P2. This ratio is used with P2 to calculate the value of P1.0 using the formula: P1.0 = R0 x P2. The power calculations assume that P1.0 is the value of the P1 under the null hypothesis. In this non-null case, the value of P1.0 is not equal to P2 as it is in the null case.

You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Ratios must greater than zero.

R1 (Ratio|H1 = P1.1/P2)

This option specifies the ratio of P1.1 and P2, where P1.1 is the proportion in group 1 under the alternative hypothesis. This ratio is used with P2 to calculate the value of P1.1 using the formula: P1.1 = R1 x P2. The power calculations assume that P1.1 is the actual value of the proportion in group 1 (experimental or treatment group).

You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Ratios must greater than zero. They cannot take on the value of one.

Effect Size – Group 2 (Reference)

P2 (Group 2 Proportion)

Specify the value of P2, the control, baseline, or standard group’s proportion. The null hypothesis is that the two proportions differ by a specified amount. Since P2 is a proportion, these values must be between zero and one.

You may enter a range of values such as 0.1,0.2,0.3 or 0.1 to 0.9 by 0.1.
Example 1 – Finding Power

A study is being designed to determine the effectiveness of a new treatment. The standard treatment has a success rate of 65%. They would like to show that the success rate ratio of the new treatment to the old treatment is at least 1.1.

The researchers plan to use the Farrington and Manning likelihood score test statistic to analyze the data that will be (or has been) obtained. They want to study the power of the Farrington and Manning test at group sample sizes ranging from 50 to 200 for detecting a ratio of 1.1 when the actual ratio ranges from 1.2 to 1.5. The significance level will be 0.025.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Unity Null Tests for the Ratio of Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Test (Non-Zero Null), and then clicking on Non-Unity Null Tests for the Ratio of Two Proportions. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For:</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Normal Approximation</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided (H1: P1/P2 &gt; R0)</td>
</tr>
<tr>
<td>Test Type</td>
<td>Likelihood Score (Farr. &amp; Mann.)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>50 100 150 200</td>
</tr>
<tr>
<td>R0 (Ratio</td>
<td>H0 = P1.0/P2)</td>
</tr>
<tr>
<td>R1 (Ratio</td>
<td>H1 = P1.1/P2)</td>
</tr>
<tr>
<td>P2 (Group 2 Proportion)</td>
<td>0.65</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power*</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>Ref. P2</th>
<th>P1</th>
<th>H0</th>
<th>P1.0</th>
<th>P1</th>
<th>H1</th>
<th>P1.1</th>
<th>Rat.</th>
<th>H0</th>
<th>R0</th>
<th>1.20</th>
<th>1.20</th>
<th>0.0250</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.10144</td>
<td>50</td>
<td>50</td>
<td>100</td>
<td>0.6500</td>
<td>0.7150</td>
<td>0.7800</td>
<td>1.10</td>
<td>1.20</td>
<td>0.0250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.16144</td>
<td>100</td>
<td>100</td>
<td>200</td>
<td>0.6500</td>
<td>0.7150</td>
<td>0.7800</td>
<td>1.10</td>
<td>1.20</td>
<td>0.0250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.22064</td>
<td>150</td>
<td>150</td>
<td>300</td>
<td>0.6500</td>
<td>0.7150</td>
<td>0.7800</td>
<td>1.10</td>
<td>1.20</td>
<td>0.0250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.27900</td>
<td>200</td>
<td>200</td>
<td>400</td>
<td>0.6500</td>
<td>0.7150</td>
<td>0.7800</td>
<td>1.10</td>
<td>1.20</td>
<td>0.0250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.30085</td>
<td>50</td>
<td>50</td>
<td>100</td>
<td>0.6500</td>
<td>0.7150</td>
<td>0.8450</td>
<td>1.10</td>
<td>1.30</td>
<td>0.0250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.53006</td>
<td>100</td>
<td>100</td>
<td>200</td>
<td>0.6500</td>
<td>0.7150</td>
<td>0.8450</td>
<td>1.10</td>
<td>1.30</td>
<td>0.0250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.70327</td>
<td>150</td>
<td>150</td>
<td>300</td>
<td>0.6500</td>
<td>0.7150</td>
<td>0.8450</td>
<td>1.10</td>
<td>1.30</td>
<td>0.0250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.82128</td>
<td>200</td>
<td>200</td>
<td>400</td>
<td>0.6500</td>
<td>0.7150</td>
<td>0.8450</td>
<td>1.10</td>
<td>1.30</td>
<td>0.0250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.
Non-Unity Null Tests for the Ratio of Two Proportions

References

Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
P2 is the proportion for Group 2, which is the standard, reference, or control group.
P1 is the proportion for Group 1, which is the treatment or experimental group. P1.0 is the Group 1 proportion under the null hypothesis. P1.1 is the proportion for Group 1 under the alternative hypothesis at which power and sample size calculations are made.
R0 is the ratio (P1/P2) under the null hypothesis. R1 is the ratio under the alternative hypothesis used for power and sample size calculations.
Alpha is the probability of rejecting a true null hypothesis.

Summary Statements
Group sample sizes of 50 in Group 1 and 50 in Group 2 achieve 10.144% power to detect a ratio of 1.2000 when the null-hypothesized ratio is 1.1000. The Group 2 proportion is 0.6500. The Group 1 proportion is assumed to be 0.7150 under the null hypothesis and 0.7800 under the alternative hypothesis. The test statistic used is the one-sided Score test (Farrington & Manning). The significance level of the test is 0.0250.

This report shows the values of each of the parameters, one scenario per row.

Plots Section

The values from the table are displayed in the above charts. These charts give us a quick look at the sample size that will be required for various values of R1.
Example 2 – Finding the Sample Size

Continuing with the scenario given in Example 1, the researchers want to determine the sample size necessary for each value of R1 to achieve a power of 0.80.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Unity Null Tests for the Ratio of Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Test (Non-Zero Null), and then clicking on Non-Unity Null Tests for the Ratio of Two Proportions. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option Value
Design Tab
Solve For Sample Size
Power Calculation Method Normal Approximation
Alternative Hypothesis One-Sided (H1: P1/P2 > R0)
Test Type Likelihood Score (Farr. & Mann.)
Power 0.80
Alpha 0.025
Group Allocation Equal (N1 = N2)
R0 (Ratio|H0 = P1.0/P2) 1.1
R1 (Ratio|H1 = P1.1/P2) 1.2 1.3 1.4 1.5
P2 (Group 2 Proportion) 0.65

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Test Statistic: Farrington &amp; Manning Likelihood Score Test</th>
<th>Hypotheses: H0: P1/P2 ≤ R0 vs. H1: P1/P2 &gt; R0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Power, Actual Power*</td>
<td>N1</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---</td>
</tr>
<tr>
<td>0.80 0.80013</td>
<td>831</td>
</tr>
<tr>
<td>0.80 0.80156</td>
<td>190</td>
</tr>
<tr>
<td>0.80 0.80202</td>
<td>74</td>
</tr>
<tr>
<td>0.80 0.80818</td>
<td>35</td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

The required sample size will depend a great deal on the value of R1. Any effort spent determining an accurate value for R1 will be worthwhile.
Example 3 – Comparing the Power of the Three Test Statistics

Continuing with Example 2, the researchers want to determine which of the eight possible test statistics to adopt by using the comparative reports and charts that PASS produces. They decide to compare the powers from binomial enumeration and actual alphas for various sample sizes between 800 and 1000 when R1 is 1.2.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Unity Null Tests for the Ratio of Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Test (Non-Zero Null), and then clicking on Non-Unity Null Tests for the Ratio of Two Proportions. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Binomial Enumeration</td>
</tr>
<tr>
<td>Maximum N1 or N2 for Binomial Enumeration</td>
<td>5000</td>
</tr>
<tr>
<td>Zero Count Adjustment Method</td>
<td>Add to zero cells only</td>
</tr>
<tr>
<td>Zero Count Adjustment Value</td>
<td>0.0001</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided (H1: P1/P2 &gt; R0)</td>
</tr>
<tr>
<td>Test Type</td>
<td>Likelihood Score (Farr. &amp; Mann.)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>800 900 1000</td>
</tr>
<tr>
<td>R0 (Ratio</td>
<td>H0 = P1.0/P2)</td>
</tr>
<tr>
<td>R1 (Ratio</td>
<td>H1 = P1.1/P2)</td>
</tr>
<tr>
<td>P2 (Group 2 Proportion)</td>
<td>0.65</td>
</tr>
</tbody>
</table>

Reports Tab

Show Comparative Reports: Checked

Comparative Plots Tab

Show Comparative Plots: Checked
Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results and Plots**

**Power Comparison of Three Different Tests**

<table>
<thead>
<tr>
<th>N1/N2</th>
<th>P2</th>
<th>P1.1</th>
<th>F.M. Score</th>
<th>Power</th>
<th>M.N. Score</th>
<th>Power</th>
<th>G.N. Score</th>
<th>Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>800/800</td>
<td>0.6500</td>
<td>0.7800</td>
<td>0.0250</td>
<td>0.7855</td>
<td>0.7854</td>
<td>0.7855</td>
<td></td>
<td></td>
</tr>
<tr>
<td>900/900</td>
<td>0.6500</td>
<td>0.7800</td>
<td>0.0250</td>
<td>0.8311</td>
<td>0.8311</td>
<td>0.8305</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000/1000</td>
<td>0.6500</td>
<td>0.7800</td>
<td>0.0250</td>
<td>0.8678</td>
<td>0.8674</td>
<td>0.8674</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Power was computed using binomial enumeration of all possible outcomes.

**Actual Alpha Comparison of Three Different Tests**

<table>
<thead>
<tr>
<th>N1/N2</th>
<th>P2</th>
<th>P1.1</th>
<th>F.M. Score</th>
<th>Alpha</th>
<th>M.N. Score</th>
<th>Alpha</th>
<th>G.N. Score</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>800/800</td>
<td>0.6500</td>
<td>0.7800</td>
<td>0.0250</td>
<td>0.0250</td>
<td>0.0250</td>
<td>0.0250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>900/900</td>
<td>0.6500</td>
<td>0.7800</td>
<td>0.0250</td>
<td>0.0250</td>
<td>0.0250</td>
<td>0.0250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000/1000</td>
<td>0.6500</td>
<td>0.7800</td>
<td>0.0250</td>
<td>0.0251</td>
<td>0.0250</td>
<td>0.0251</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Actual alpha was computed using binomial enumeration of all possible outcomes.

All three test statistics have about the same power for all sample sizes studied.
Example 4 – Comparing Power Calculation Methods

Continuing with Example 3, let’s see how the results compare if we were to use approximate power calculations instead of power calculations based on binomial enumeration.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Unity Null Tests for the Ratio of Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Test (Non-Zero Null), and then clicking on Non-Unity Null Tests for the Ratio of Two Proportions. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Normal Approximation</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided (H1: P1/P2 &gt; R0)</td>
</tr>
<tr>
<td>Test Type</td>
<td>Likelihood Score (Farr. &amp; Mann.)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>800 900 1000</td>
</tr>
<tr>
<td>R0 (Ratio</td>
<td>H0 = P1.0/P2)</td>
</tr>
<tr>
<td>R1 (Ratio</td>
<td>H1 = P1.1/P2)</td>
</tr>
<tr>
<td>P2 (Group 2 Proportion)</td>
<td>0.65</td>
</tr>
</tbody>
</table>

Reports Tab

Show Power Detail Report ………… Checked

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

<table>
<thead>
<tr>
<th>N1/N2</th>
<th>P2</th>
<th>R0</th>
<th>R1</th>
<th>Normal Approximation</th>
<th>Binomial Enumeration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Power</td>
<td>Alpha</td>
</tr>
<tr>
<td>800/800</td>
<td>0.650</td>
<td>1.100</td>
<td>1.200</td>
<td>0.78503</td>
<td>0.0250</td>
</tr>
<tr>
<td>900/900</td>
<td>0.650</td>
<td>1.100</td>
<td>1.200</td>
<td>0.83049</td>
<td>0.0250</td>
</tr>
<tr>
<td>1000/1000</td>
<td>0.650</td>
<td>1.100</td>
<td>1.200</td>
<td>0.86734</td>
<td>0.0250</td>
</tr>
</tbody>
</table>

Notice that the approximate power values are very close to the binomial enumeration values for all sample sizes.
Example 5 – Validation of Power Calculations using Blackwelder (1993)

Blackwelder (1993), page 695, presents a table of power values for several scenarios using the risk ratio. The second line of the table presents the results for the following scenario: \( P_2 = 0.04, R_0 = 0.3, R_1=0.1, N_1=N_2=1044, \) one-sided alpha = 0.05, and beta = 0.20. Using the Farrington and Manning likelihood-score test statistic, he found the binomial enumeration power to be 0.812, the actual alpha to be 0.044, and, using the asymptotic formula, the approximate power to be 0.794.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Unity Null Tests for the Ratio of Two Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Test (Non-Zero Null), and then clicking on Non-Unity Null Tests for the Ratio of Two Proportions. You may then make the appropriate entries as listed below, or open Example 5(a or b) by going to the File menu and choosing Open Example Template.

Option | Value
---|---
**Design Tab**
Solve For | Power
Power Calculation Method | Binomial Enumeration
Maximum N1 or N2 for Binomial Enumeration | 5000
Zero Count Adjustment Method | Add to zero cells only
Zero Count Adjustment Value | 0.0001
Alternative Hypothesis | One-Sided (H1: \( P_1/P_2 < R_0 \))
Test Type | Likelihood Score (Farr. & Mann.)
Alpha | 0.05
Group Allocation | Equal (N1 = N2)
Sample Size Per Group | 1044
R0 (Ratio|H0 = P1.0/P2) | 0.3
R1 (Ratio|H1 = P1.1/P2) | 0.1
P2 (Group 2 Proportion) | 0.04

**Output**

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

| Power | N1 | N2 | N | Ref. P2 | P1|H0 | P1.0 | Ref. P1.1 | P1|H1 | Rat.|H0 | R0 | Rat.|H1 | R1 | Target Alpha | Actual Alpha |
|-------|----|----|---|--------|----|----|------|----------|----|----|-----|----|----|-----|----|--------------|-------------|
| 0.81178 | 1044 | 1044 | 2088 | 0.0400 | 0.0120 | 0.0040 | 0.300 | 0.100 | 0.0500 | 0.0444 |

* Power and actual alpha were computed using binomial enumeration of all possible outcomes.

PASS calculated the power to be 0.81178 and the actual alpha to be 0.0444, which round to Blackwelder’s values.
Next, to calculate the asymptotic power, we make the following changes to the template:

**Option**  
Power Calculation Method ...................... Normal Approximation

### Numeric Results

| Test Statistic: Farrington & Manning Likelihood Score Test  
| Hypotheses: H0: P1/P2 ≥ R0 vs. H1: P1/P2 < R0 |
| Power*  
| N1  
| N2  
| N  
| Ref. P2  
| P1|H0  
| P1|H1  
| Rat.|H0  
| Rat.|H1  
| N  
| P2  
| P1.0  
| P1.1  
| R0  
| R1  
| Alpha |
| 0.79373  
| 1044  
| 1044  
| 2088  
| 0.0400  
| 0.0120  
| 0.0040  
| 0.300  
| 0.100  
| 0.0500 |

* Power was computed using the normal approximation method.

PASS also calculated the power to be 0.794.